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7. DESARROLLO DE UNA HERRAMIENTA PARA 
MONITOR EL CRECIMIENTO Y RENDIMIENTO DE 
CULTIVOS 

 
Antonio de la Casa1 y Gustavo Ovando2 

 
El Centro de Relevamiento y Evaluación de Recursos Agrícolas y Naturales (CREAN) es una unidad de 
investigación aplicada de la Facultad de Ciencias Agrícolas de la Universidad Nacional de Córdoba (Argentina). El 
objetivo general de CREAN es contribuir al desarrollo de estrategias para la gestión sostenible de los recursos 
naturales y agrícolas, basadas en el uso racional de la conservación y recuperación del patrimonio ambiental. Este 
consiste en la elaboración de programas de aplicación utilizando la información de teledetección y de los sistemas de 
información geográfica. CREAN desempeña un papel activo para desarrollar nuevas metodologías destinadas a 
evaluar los procesos de desertificación, la productividad y rendimiento de cultivos y su distribución geográfica. 
Además, el centro ofrece apoyo tecnológico a los sectores público y privado sobre los usos y aplicaciones de 
información meteorológica y los recursos naturales. 

7.1. Importancia del tema seleccionado 
El monitoreo de los cultivos agrícolas a lo largo de la temporada de crecimiento puede proporcionar información 
para hacer predicciones de rendimiento antes de la cosecha. Esto es importante para la toma de decisiones a 
diferentes niveles, tanto para la logística como para las actividades de comercialización (Rizzi y Rudorff 2005). 
El rendimiento de un cultivo está determinado por sus características genéticas y las condiciones que prevalecen 
durante el período de crecimiento, tales como las condiciones climáticas y meteorológicas, fertilidad del suelo, 
control de plagas y enfermedades, el estrés hídrico y otros factores que afectan el crecimiento del cultivo. El 
rendimiento de los cultivos puede variar ostensiblemente en función de las condiciones dominantes. El rendimiento 
esperado de acuerdo a distintas condiciones de crecimiento se puede estimar por medio de modelos mecanísticos de 
crecimiento de cultivos (Boote et al. 1998, Brisson et al, 2003; Yang et al, 2004). Este tipo de modelos no sólo simula 
el rendimiento, sino también el desarrollo del cultivo durante todo su ciclo de crecimiento. Los modelos 
mecanicistas, sin embargo, requieren generalmente de un conjunto enorme de datos de entrada que a menudo es 
difícil de conseguir fuera de los centros de investigación. Asimismo, como requieren también de una adecuada 
calibración específica para el sitio de uso antes de poder ser aplicados, este tipo de modelo no suele ser muy útil para 
el desarrollo de estrategias de riego o cuando se lo aplica para realizar evaluaciones en condiciones prácticas. 
Para fines de planificación y evaluación agrícola a partir de datos limitados, existe un enfoque más general y sencillo. 
La modelo funcional presentado por Doorenbos y Kassam (1979), que describe la relación entre el estrés hídrico y el 
la pérdida de productividad correspondiente es de gran utilidad: 

     
       

 
Donde Ya/Ymax es el rendimiento relativo; (1-Ya/Ymax) la disminución del rendimiento relativo, ETa/ETmax la 
evapotranspiración relativa, y (1-ETa/ETmax) es la falta de agua o déficit de la evapotranspiración relativa. 
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La respuesta del rendimiento a la falta de agua en un ambiente determinado, se cuantifica a través del factor de 
respuesta del rendimiento (Ky). La relación entre la disminución del rendimiento y la falta de agua es lineal, siempre y 
cuando la escasez de agua no supere el 50%. En el modelo, el rendimiento real (Ya) se expresa como una fracción del 
rendimiento máximo (Ymax), que se puede alcanzar cuando la disponibilidad de agua no limita el crecimiento. ETa 
se refiere a la evapotranspiración real o actual del cultivo de acuerdo a condiciones de crecimiento, y ETmax es la 
evapotranspiración en las mismas condiciones, pero bajo un suministro de agua no limitante. 
Este modelo funcional se ha aplicado de diferentes maneras según el tipo y la disponibilidad de la información 
utilizada (Rojas, 2007). Raes et al. (2006) emplearon un procedimiento de balance de agua para estimar ETa a partir 
de información meteorológica (ETmax y datos de precipitación), así como las características del suelo en relación con 
el contenido de agua para calcular la pérdida de rendimiento de los cultivos.  
La teledetección espacial ofrece información extendida territorialmente sobre el estado actual de los cultivos, y se ha 
utilizado también para apoyar la parametrización de los modelos de cultivos (Guérif y Duke, 2000). Las ventajas que 
ofrece la teledetección se han explotado en los últimos años para monitorear la vegetación y evaluar el impacto de la 
sequía sobre el rendimiento de los cultivos. Caselles et al. (1993) utilizaron imágenes NDVI de NOAA-AVHRR para 
determinar, junto con los datos de campo, los diversos componentes del modelo de productividad de la FAO. Funk 
y Budde (2009) presentaron un desglose detallado de los estudios sobre el rendimiento de los cultivos y el NDVI, y 
sostienen la conveniencia de ajustar la relación entre la sequía y la productividad sobre la base de datos fenológicos. 
De la Casa y Ovando (2007) desarrollaron un modelo de cultivo para estimar el rendimiento de maíz a nivel 
regional/departamental, integrando datos de NDVI con información fenológica. 
Una estrategia conveniente para que los métodos de estimación de rendimiento resulten más robustos y fácilmente 
transferibles es realizar la integración de los datos de teledetección con los modelos de simulación de cultivos 
(Doraiswamy et al., 2003). Moriondo et al. (2007) presentan el desarrollo y prueba de un marco metodológico que 
utiliza datos de NDVI y un modelo de simulación (CropSyst) para estimar la fenología del cultivo. Esta operación se 
desarrolla en dos pasos principales, el primero es el cálculo de la biomasa aérea (AGB), que se obtiene mediante el 
uso de NDVI derivado de la fracción de la radiación fotosintéticamente activa absorbida (fAPAR), estimado de la 
siguiente forma: 

  

   

 
 
Como la fracción del suelo cubierto por el follaje (fCov) se puede considerar similar a fAPAR en maíz (Edwards et 
al, 2005) y soja (Purcell, 2000), esta expresión es reescrita como sigue: 
 

 
Donde εi y PARi son la eficiencia en el uso de radiación (RUE, g MJ-1) y la radiación fotosintética activa (PAR) en el 
día i, respectivamente, y n es el número de días simulados. 
El segundo paso consiste en la partición final de la biomasa estimada en el rendimiento del cultivo máximo (Ymax), 
que se obtiene a través de la utilización del índice de cosecha (HI), donde HI adopta un valor de 0,47 para el maíz y 
la soja. 
 

 
La evapotranspiración real (ETa) se puede estimar utilizando diferentes alternativas de cálculo en función de la 
fuentes de información disponibles. El balance hídrico del suelo es utilizado habitualmente, pero necesita datos de 
precipitación (PP) y evapotranspiración máxima (ETmax) del cultivo, así como información sobre el tipo de suelo y 
su capacidad para retener agua. De una manera similar pero más simplificada, los valores de NDVI se consideran 
sustitutos de la tasa de transpiración (Funk y Budde, 2009) y, por lo tanto, el modelo de productividad de la FAO se 
puede adaptar de acuerdo con la siguiente expresión: 
 
 
 
 
Dónde ΣNDVIa es el valor de NDVI acumulado durante todo el ciclo o en cada etapa de desarrollo, y ΣNDVImax 
el valor acumulado más alto de todos los campos. 
 

aNDVIbfAPAR −×=

∑ =
××=

n

i iii PARfAPARAGB
1
ε

∑ =
××=

n

i iii PARfCovAGB
1
ε

HIAGBY ×=max

Eq. 2 

Eq. 3 

Eq. 4 

Eq. 6 

Eq. 5 



MANUAL DE APLICACION 

3 

El Gobierno de la provincia de Córdoba compila las estadísticas de la producción agrícola que obtiene a partir de 
métodos tradicionales basados en encuestas de campo para establecer la superficie plantada/cosechada, rendimiento 
y producción de los cultivos de importancia económica a escala de departamento (SAyGA, 2010). Estos métodos son 
laboriosos, requieren personal de campo y no generan resultados de manera tan inmediata como exigen los mercados 
agrícolas (Rosenthal et al., 1998).). 

7.2. Objetivo de la aplicación 
Esta aplicación propone desarrollar un procedimiento semi-operativo para estimar los rendimientos de maíz y soja en 
la Provincia de Córdoba, Argentina. El procedimiento se llevará a cabo en un marco regional haciendo uso de 
diferentes rutinas del programa ILWIS para calcular los componentes del modelo de productividad de la FAO, a 
partir de datos de NDVI del satélite MODIS, e información de campo local (in situ).  

7.2.1. Recopilación de datos y preprocesamiento  

7.2.2. Datos de NDVI 
Asegúrese de que ha descomprimido los datos del ejercicio y compruebe su posición mediante el navegador de 
ILWIS en este directorio activo de trabajo. Cierre el programa e inicie nuevamente una sesión de ILWIS para 
asegurarse de que la configuración del directorio es la correcta. Puede echar un vistazo a los datos que están 
disponibles en esta carpeta, abrir el mapa (imagen) de la lista "sub_modis_ndvi" y mostrar la lista de mapas como una 
secuencia animada, utilizando "NDVI1" como representación. Para esta aplicación fueron seleccionadas 17 imágenes 
raster NDVI (MODIS-MOD13Q1, producto de 16 días, 250 m, del sector h12v12, en formato ENVI), desde 
septiembre de 2005 a mayo de 2006. Estas imágenes fueron transformadas al formato de imagen ILWIS y un sub-
mapa fue preparado para cubrir la región de interés. Más detalles figuran en el cuadro 7.1. 
 

Nombre del archivo raster Desde Hasta SRAD 

sub_modis_ndvi_1.mpr 6-Sep-05 21-Sep-05 11.6 
sub_modis_ndvi_2.mpr 22-Sep-05 7-Oct-05 16.8 
sub_modis_ndvi_3.mpr 8-Oct-05 23-Oct-05 18.2 
sub_modis_ndvi_4.mpr 24-Oct-05 8-Nov-05 19.8 
sub_modis_ndvi_5.mpr 9-Nov-05 24-Nov-05 20.7 
sub_modis_ndvi_6.mpr 25-Nov-05 10-Dec-05 21.6 
sub_modis_ndvi_7.mpr 11-Dec-05 26-Dec-05 20.5 
sub_modis_ndvi_8.mpr 27-Dec-05 11-Jan-06 23.1 
sub_modis_ndvi_9.mpr 9-Jan-06 24-Jan-06 23.3 
sub_modis_ndvi_10.mpr 25-Jan-06 9-Feb-06 19.0 
sub_modis_ndvi_11.mpr 10-Feb-06 25-Feb-06 19.6 
sub_modis_ndvi_12.mpr 26-Feb-06 13-Mar-06 22.2 
sub_modis_ndvi_13.mpr 14-Mar-06 29-Mar-06 18.2 
sub_modis_ndvi_14.mpr 30-Mar-06 14-Apr-06 17.6 
sub_modis_ndvi_15.mpr 15-Apr-06 30-Apr-06 13.8 
sub_modis_ndvi_16.mpr 1-May-06 16-May-06 15.8 
sub_modis_ndvi_17.mpr 17-May-06 1-Jun-06 14.1 

Tabla 7.1 Imágenes NDVI utilizadas, detalle temporal y datos de radiación solar diaria de la estación 
Manfredi INTA (SRAD, MJ m-2). 

7.2.3. Mapa de los límites administrativos (departamentos) 
Los límites administrativos se han obtenido a partir de un mapa vectorial con los límites departamentales de la 
Provincia de Córdoba. Este mapa vectorial originalmente en formato de intercambio (DXF), fue importado a ILWIS 
y ha sido nombrado "boundary". En “Display Opciones” agregue el archivo de polígono "boundary" a la ventana de 
visualización del mapa (imagen) activo, usando "información off" y "Boundary only". 
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7.2.4. Datos meteorológicos 
El procedimiento utiliza los datos diarios de radiación solar de la estación meteorológica de Manfredi (31° 49' 12''S, 
63° 46' 00''W, altitud 292 m s/n/m), que está ubicada en la zona central de Córdoba. A partir de estos datos se 
calculó el valor acumulado por cada período de la imagen (véase la Tabla 7.1).  

7.2.5. Mediciones de la fracción de suelo cubierta por el cultivo (fCov) 
Mediciones de campo de fCov fueron realizadas a partir de fotografías digitales que se clasificaron con un algoritmo 
de máxima verosimilitud, como se muestra en la figura 7.1. Fotos de cultivos de soja y maíz se recolectaron durante 3 
años, incluyendo el ciclo de cultivo 2005-2006, en varios campos en la región central de Córdoba. Las fotos fueron 
tomadas verticalmente desde una altura de 1,5 m. Un total de 150 imágenes se clasificaron para soja y maíz.  

F igura 7.1 Mediciones de fCov en maíz, con la foto orig inal (izquierda) y la imagen clasificada (derecha) 
 
Los valores de fCov se analizaron mediante regresión con el NDVI para obtener un modelo de estimación que se 
utilizó en ambos cultivos. La modelo utilizado es el siguiente:  
 

7.2.6. Datos departamentales de rendimiento de los cultivos 
La Secretaría de Agricultura de la Provincia de Córdoba elabora y suministra estadísticas de la producción agrícola a 
nivel departamental. Las mismas se elaboran a partir de métodos tradicionales basados en informes y relevamiento de 
campo para establecer la superficie plantada, cosechada, rendimiento y producción de los cultivos de importancia 
económica en la región (SAyGA, 2010). Los detalles figuran en la Tabla 7.2. 
 
 

Número de 
identificación 

Departmento 
Rendimiento (kg ha-1) 

Maíz Soja 

1 Calamuchita 7,000 2,442 
2 General Roca 6,800 2,300 

3 Gral. San Martín 5,500 2,150 

4 Juárez Celman 6,000 2,370 

5 Marcos Juárez 8,000 3,300 

6 Pte. R. S. Peña 6,500 2,200 

7 Río Cuarto 4,000 2,000 

8 Río Primero 6,000 2,200 

9 Río Segundo 7,000 2,300 

10 San Justo 5,500 2,050 

11 Santa María 6,500 2,400 

12 Tercero Arriba 6,500 2,800 

13 Unión 7,000 2,442 

Tabla 7.2 Rendimientos de maíz y soja en los principales Departamentos agrícolas de Córdoba en la 
temporada de cultivo 2005-2006. 

245,0228,1 −×= NDVIfCov
Eq. 7 
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7.3. Metodología 
El diagrama de flujo que muestra el procedimiento seguido para estimar el rendimiento de grano se presenta a 
continuación en la Figura 7.2. 

Figura 7.2 Diagrama de flujo con la metodología adoptada 

7.4. Procesamiento y análisis de los datos 
Los distintos pasos del procesamiento, como se indican en la figura 7.2, se presentan en forma más pormenorizada a 
continuación. 

7.4.1. Imagenes de NDVI (paso ❶) 
Una vez más despliegue una de las 17 imágenes de NDVI, abra la lista (pila) de mapas "sub_modis_ndvi" y muestre 
como ejemplo la primera de ellas "sub_modis_ndvi_1", utilizando para “Representation” la paleta "NDVI1". Tenga 
en cuenta que la mayoría del pre-procesamiento necesario ya se ha hecho, esto principalmente con el fin de limitar el 
tamaño de los archivos necesarios para realizar el ejercicio. Compruebe los valores de mapa pulsando el botón 
izquierdo del ratón y recorriendo con el ratón sobre la ventana del mapa activo. Tenga en cuenta el intervalo de 
tiempo de cada una de las imágenes NDVI como figura en la Tabla 7.1. Añada a la ventana del mapa activo el 
archivo de polígono "boundary", utilizando la opción de visualización "Boundaries Only". Desde el menú del mapa 



APPLICATION MANUAL 

6 

Figura 7.4 Perfiles del NDVI 

activo Map Window, seleccione “File =>Open Pixel Information”. Compruebe el contenido de la imagen desde la 
ventana de información de los píxeles, y observe que se han añadido los datos del rendimiento departamental de los 
cultivos, idénticos a los de la Tabla 7.2. Muévase con el cursor sobre el departamento situado más al norte, llamado 
San Justo y tenga en cuenta los efectos negativos sobre los valores de NDVI del cuerpo de agua adyacente. Estos 
valores negativos de NDVI no representan la vegetación y, por lo tanto, estos valores serán reclasificados como 
“valores sin datos". Cierre todas las ventanas de mapa activas. Ahora desde la ventana principal de ILWIS, seleccione 
las opciones “Operations => Raster Operations => Maplist Calculation”. Llene la ventana de cálculo MapList como 
se indica en la Figura 7.3 y pulse el botón "Show" para ejecutar la operación. Muestre el resultado de MapList 
"sub_modis_ndvi_und" como una secuencia animada y revise los valores, considerando que donde no hay datos está 
representada por un "?" 

Figura 7.3 Reclasificación de los valores negativos de NDVI como valores sin dato (?)  

7.4.2. Radiación solar (paso ❷) 
Los valores de radiación solar utilizados se presentan en la Tabla 7.1 (ver columna SRAD), y se describen en la 
sección Datos meteorológicos en el Capítulo 7.3.3.  

7.4.3. Clasificación de cultivos (paso ❸) 
Para evaluar la existencia de diferentes cultivos se adoptó un método de 
clasificación multicriterio a partir del conocimiento de ciclos fenológicos de 
maíz y de soja en la provincia de Córdoba, de acuerdo a lo que se refleja en 
los perfiles de NDVI, véase también la figura 7.4. La soja se cultiva en dos 
formas diferentes: la soja tardía (soybean_2) se siembra después del trigo, 
por lo que se espera que los valores de NDVI de septiembre sean altos, son 
más bajos en diciembre en el momento de la cosecha,  hasta alcanzar un 
máximo en febrero, cuando la cubierta de soja se completa. Siguiendo este 
criterio se puede calcular un mapa raster booleano escribiendo la siguiente 
expresión en la línea de comandos del menú principal de ILWIS: 
 

soybean_2:=iff((sub_modis_ndvi_und_1>0.6)and(sub_modis_ 
ndvi_und_7<0.3) and(sub_modis_ndvi_und_11>0.7),1,0) 

 
Pulse Enter para ejecutar la operación y, después de realizar el cálculo, 
presente el mapa en pantalla. Por otro lado, como la soja temprana 
(soybean_1) se realiza después del descanso invernal, el NDVI de 
septiembre es bajo. La siembra de la soja se inicia en noviembre de modo 
que el NDVI máximo aparece a finales de diciembre y luego desciende al 

producirse la cosecha. Para separar este cultivo se utiliza la siguiente expresión:  
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soybean_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_8>0.7)and(sub_modis_ndvi_und
_12>0.5)and(sub_modis _ndvi_und_15<0.3),1,0) 

 
Para el maíz, similar a la soja temprana, el valor mínimo de NDVI se produce en septiembre, pero como las 
necesidades térmicas de este cultivo son inferiores a la soja, la siembra suele ser anterior por lo que su valor máximo 
de NDVI ocurre antes en noviembre (corn_1) o diciembre (corn_2). Las expresiones utilizadas para la clasificación 
del maíz son:  

corn_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_6>0.6)and(sub_modis_ndvi_und_15
<0.3),1,0) 
 
corn_2:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_7>0.7)and(sub_modis_ndvi_und_12
<0.5)and(sub_modis_ndvi_und_15<0.3),1,0) 

 
Ejecute estas expresiones desde la línea de comando del menú principal de ILWIS, muestre en pantalla y verifique los 
resultados. Para este ejercicio sólo necesitamos conocer dónde se cultiva soja y maíz porque los cultivos poseen 
diferente valor de eficiencia en el uso de la radiación (ε), para eso realice un único mapa Booleano para cada cultivo 
usando los siguientes comandos:  
 

soybean:=iff((soybean_1=1)or(soybean_2=1),1,0) 
corn:=iff((corn_1=1)or(corn_2=1),2,0) 
 

Para verificar los resultados de la clasificación, básicamente para comprobar si los cultivos fueron clasificados dos 
veces, se puede agrupar los dos cultivos en un mismo mapa, usando las siguientes expresiones desde la línea de 
comando del menú principal de ILWIS: 
 
 class_check:=corn+soybean 
 
Ahora se propone abrir el mapa (imagen) creado usando como “Representation” la paleta “lai_SAF” y chequear los 
resultados, notando que los valores resultantes presentan un rango entre 0 y 3, ya que al maíz se le ha asignado un 
valor de 2! Cierre el mapa y presione el botón derecho del ratón sobre el mapa “class_check”, directamente desde el 
menú sensitivo de contexto, seleccione la opción “Statistics => Histogram” y presione “Show” para ver las 
estadísticas por clase. Para corregir el error de clasificación, debe ejecutarse la siguiente expresión desde la línea de 
comando del menú principal de ILWIS: 
 
 class_cor:=iff(class_check<3,class_check,0) 
 
Visualice el mapa usando la paleta “lai_SAF” como Representation y verifique sus resultados, note que el rango de 
valores ahora es entre 0 y 2, la soja ahora está clasificada con el valor de 1 y el maíz ha obtenido un valor de 2. 
Finalmente, debe ser considerada la distribución de los píxeles clasificados por departamento. Pulse el botón derecho 
del ratón sobre el mapa de polígonos “boundary”, desde el menú de contexto sensitivo, seleccione la opción 
“Polygon to Raster”, como Output Raster Map, mantenga “boundary”, use como Georeference 
“sub_modis_ndvi_1” y presione “Show”. Note que el mapa ha sido remuestreado al sistema de georreferencia del 
NDVI, el cual está en la proyección original de MODIS, denominada Proyección Sinusoidal, por lo tanto los límites 
parecen estar distorsionados. El próximo paso consiste en cruzar el mapa raster “boundary” con el mapa “class_cor”, 
seleccione desde el menú principal de ILWIS la opción “Operations => Raster Operations => Cross” , como 1st 
Map especifique “boundary” y como 2nd map seleccione “class_cor”, como Output Table especifique 
“representation_department” y presione “Show”. Verifique los resultados que muestra la tabla en pantalla, 
escribiendo las siguientes expresiones en la línea de comando: 
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 pixel_soybean:=iff(class_cor=1,npix,?) 
 pixel_corn:=iff(class_cor=2,npix,?) 
 
Nuevas columnas son creadas que muestran el número de píxeles que representan maíz y soja por departamento. 
Estas dos nuevas columnas creadas serán añadidas a la tabla de atributos “boundary”. Cierre la tabla 
“representation_department” y abra la tabla “boundary”. Desde el menú de la tabla activa, seleccione la opción 
“Column => Join”, como Table seleccione “representation_department” y como Column “pixel_soybean”, presione 
“Next” 4 veces, acepte por defecto Output Column “pixel_soybean” y presione “Finish” y “OK”. Repita este 
procedimieto para unir también la columna “pixel_corn”. Sus resultados deberían aparecer como muestra la Figura 
7.5 

Figura 7.5 Rendimiento y número de píxeles por Departamento para maíz y soja 

7.4.4. Suma de NDVI (paso ❹) 
Para calcular la suma de NDVI a partir de la totalidad de imágenes a lo largo del ciclo del cultivo (desde la banda 7 a 
14) se emplea la utilidad Maplist Statistics para obtener la imagen ndvi_sum. A partir de la ventana principal de 
ILWIS, seleccione la opción “Operations => Statistics => MapList =>Maplist Statistics”. Complete la ventana 
MapList Statistics como se muestra en la figura 7.6 y presione “Show” para ejecutar la operación.  

Figura 7.6 Función MapList Sum  
 
Muestre el mapa resultante “ndvi_sum” usando como representación la paleta “lai” y observe los valores máximo y 
mínimo del mapa. Mueva el ratón con el botón izquierdo presionado sobre la ventana del mapa activo. 

7.4.5. Cálculo de fCov*PAR (pasos ❺ y ❻) 
El valor de fCov es calculado empleando la ecuación 7 (ver capítulo 7.3.4), para cada uno de los mapas de NDVI 
obtenidos durante el ciclo del cultivo (desde la banda 7 a 14). Esto puede ser combinado con el promedio de la 
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radiación solar transformada a PAR (PAR=SRAD*0.5) para un período de 16 días (ver tabla 7.1). Escriba la siguiente 
expresión en la línea de comando del menú principal de ILWIS: 
 

fCov_PAR7:=(sub_modis_ndvi_und_7*1.228-0.245)*10.25*16 
 
emplee los valores por defecto y presione “OK”. Para la primer fecha, donde la radiación solar fue 20.5, la PAR es 
10.25 Mj m-2 d-1. Muestre el mapa resultante y controle los valores obtenidos, emplee como Representación 
“Pseudo”. Repita este procedimiento para todos los otros mapas correspondientes al ciclo del cultivo empleando las 
siguientes expresiones (note el cambio de los valores de PAR): 
 

fCov_PAR8:=(sub_modis_ndvi_und_8*1.228-0.245)*11.55*16 
fCov_PAR9:=(sub_modis_ndvi_und_9*1.228-0.245)*11.65*16 
fCov_PAR10:=(sub_modis_ndvi_und_10*1.228-0.245)*9.5*16 
fCov_PAR11:=(sub_modis_ndvi_und_11*1.228-0.245)*9.8*16 
fCov_PAR12:=(sub_modis_ndvi_und_12*1.228-0.245)*11.1*16 
fCov_PAR13:=(sub_modis_ndvi_und_13*1.228-0.245)*9.1*16 
fCov_PAR14:=(sub_modis_ndvi_und_14*1.228-0.245)*8.8*16 

 
Cree un Nuevo MapList a partir de todos los mapas fCov_PAR* resultantes, a partir del menú principal de ILWIS, 
seleccione “File => Create => MapList”, especifique un nombre de Map list “fCov_Par” y agregue los mapas en 
orden secuencial usando el signo “>”. Ver también la figura 7.7. 

Figura 7.7 Maplist de fCov_PAR Final 

7.4.6. Rendimiento Máximo – Ymax (paso ❼) 
Como se muestra en el diagram de flujos (ver figura 7.2), Ymax se calcula empleando la suma de fCov_PAR, 
multiplicada por la Eficiencia en el Uso de la Radiación (ε) y el Índice de Cosecha (HI). Para calcular 
fCov_PAR_sum, emplee la opción Maplist Statistics. A partir del menu principal de ILWIS, seleccione las opciones 
“Operations => Statistics => MapList =>Maplist Statistics”. Complete la ventana MapList Statistics como se 
muestra en la figura 7.8 y presiones “Show” para ejecutar la operación. 

Figure 7.8 Función SUM de fCov_PAR de MapList Statistics 
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Como existen valores negativos, este mapa intermedio es corregido y todos los valores negativos son reasignados 
como indefinidos (?). Escriba la siguiente expresión en la línea de comando del menú principal de ILWIS: 
 

fCov_PAR_sum_cor:=iff(fCov_Par_sum ge 0,fCov_Par_sum,?) 
 

Use la configuración dada en la figura 7.9 para “Raster Map Definition” y presione“OK” para ejecutar la operación. 

 Figura 7.9 Definiciones de Mapa de Raster 
 
Para estimar el rendimiento máximo (Ymax) para cada cultivo se tuvieron en cuenta diferentes valores de ε (1.8 gr 
Mj-1 y 3.8 gr Mj-1 para soja y maíz, respectivamente (Sinclair and Mochow, 1999; Lindquist et al., 2005). Para ambos 
cultivos se asumió un índice de cosecha (HI) de 0.47. Para obtener el rendimiento estimado en kg ha-1 se necesita 
aplicar un factor de conversión de 10. Esos cálculos pueden realizarse empleando una sola expresión en la línea de 
comando del menú principal de ILWIS: 
 

Ymax_soybean:=iff(class_cor=1,fCov_Par_sum_cor*1.8*0.47*10,?) 
Ymax_corn:=iff(class_cor=2,fCov_Par_sum_cor*3.8*0.47*10,?) 
 

Ejecute ambas expresiones y controle los mapas resultantes. 

7.4.7. Rendimiento Real - Ya (paso ❽) 

A partir de datos experimentales el valor de NDVImax acumulado obtenido a partir de un conjunto de 10 lotes 
dentro del area de estudio fue 7.6 para todo el ciclo del cultivo. Para considerar diferente sensibilidad de los cultivos 
al estrés hídrico, se utilizó un valor de Ky de 2.1 y 1.3 para soja y maíz, respectivamente. Los comandos de ILWIS 
para calcular el rendimiento real se muestran a continuación: 
 

Ya_soybean:=iff(class_cor=1,Ymax_soybean-Ymax_soybean*2.1*(1-ndvi_sum/7.6),?) 
Ya_corn:=iff(class_cor=2,Ymax_corn-Ymax_corn*1.3*(1-ndvi_sum/7.6),?) 

 
Ejecute las expresiones y muestre los mapas resultantes, controle los valores obtenidos. 

7.4.8. Enmascaramiento de Imágenes (paso ❾) 
Visualice el mapa “Ya_soybean” y agréguele el mapa de polígonos “boundary” empleando Display Options Info off 
and Boundaries Only. Repita este procedimiento una vez más utilizando el mapa “Ya_corn” y controle la 
distribución de aquellos píxeles que han sido empleados para calcular el rendimiento de maíz y soja, respectivamente. 
También emplee la opción “Pixel Information”, seleccione “File => Pixel Information” a partir de la ventana active 
map display. Cierre todas las ventanas active map. 
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7.4.9. Rendimiento Departamental (paso ❿) 
Para obtener el rendimiento promedio por departamento, el rendimiento de cada region administrativa para cada 
cultivo debe ser extreído y agregado para obtener el rendimiento promedio. Para hacer esto seleccione de la pantalla 
principal de ILWIS en el menu opciones “Operations => Raster Operations => Cross”, como 1st Map seleccione 
“boundary” y como 2nd map “Ya_corn”. Como Output Table especifique “department_corn” y presione “Show” 
para ejecutar la operación. Abra la tabla “department_corn” y fíjese en el contenido de la tabla. A partir del menu 
tabla, seleccione la opción “Columns => Aggregation” y especifique las opciones de la ventana Aggregate Column 
como se indica en la figura 7.10 (izquierda) y presione “OK”. Note que el rendimiento promedio para maíz es 
calculado por departamento y el resultado es agregado a la tabla “boundary”, utilizando una nueva columna, llamada 
“Ya_corn”. Cierre la tabla cruzada. 
 
Repita la operación cruzada, ahora usando como 1st Map “boundary” y como 2nd map “Ya_soybean”. Como Output 
Table especifique “department_soybean” y presione “Show” para ejecutar la operación. De nuevo note el contenido 
de la tabla creada. Emplee nuevamente la funcion aggregation como se muestra en la figura 7.10 (derecha), utilice 
ahroa la columna “Ya_soybean”, como output table especifique “boundary” y como output column “Ya_soybean” 

 

Figura 7.10 Tabla de Agregación del rendimiento de maiz-soja por Departamento 
 
Ahora abra la tabla “boundary” es inspeccione las columnas recientemente creadas denominadas “Ya_corn” y 
“Ya_soybean”. Fijese también en la figura 7.11. A partir del menu table, seleccione las opciones “Columns => 
Statistics”, seleccione como función “Correlation” y calculi la correlación enttre las columnas “CornYield” – 
“Ya_corn” y entre las columnas “SoybeanYield” – “Ya_soybean”. 

Figura 7.11 Tabla que muestra los rendimientos observados versus calculados. 
Para calcular los errores de la estimación escriba las siguientes ecuaciones en la línea de commandos de la tabla y 
presione “OK” para ejecutarlas: 
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 Res_corn:=cornyield-ya_corn 
 Res_soybean:=soybeanyield-ya_soybean 
 
A partir del menue Table, seleccione el ícono “Graph”, en el menú “Create Graph”, desmarque el “X-Axis” y 
seleccione el “Y-axis” la columna “Res_corn” y presione “OK”. En la leyenda del gráfico de la izquierda, haga doble 
click en el item ”Res_corn” y cambie la representación a “Line”. A partir del menu Graph, seleccione “Edit => Add 
Graph => From Columns” y seleccione la columna “Res_soybean” y presione “OK”. Nuevamente haga doble click 
sobre el item “Res_soybean” en la leyenda del gráfico y cámbielo a representación como línea, eventualmente cambie 
su color. Haga doble click en el título del gráfico y cambie el nombre, repita lo mismo para la descripción del eje Y. 
Sus resultados debieran ser similares a los de la figura 7.12. 

 Figure 7.12 Análisis Residual de los rendimientos observados versus los estimados 
  

7.5. Conclusiones 
Este ejercicio muestra una metodología que fue desarrollada empleando un sistema de información geográfica para 
estimar los rendimientos de soja y maíz para la Provincia de Córdoba, Argentina, aplicando únicamente datos de 
NDVI (obtenidos a partir de MODIS, con un tamaño de pixel de 250 m) y radiación solar como información de 
superficie. 
Este procedimiento es un primer prototipo que, a pesar de su diseño simplificado, produce resultados objetivos que 
contrastan con los que produce el método de encuestas actualmente empleado por la agencia estatal, de carácter más 
cualitativo. Debe notarse que en general muy pocos pixeles han sido empleados para calcular el rendimiento 
promedio de maíz, para el Departamento de Calamuchita sólo 13 píxeles se han utilizado. Esto podría explicar el alto 
valor de residuo obtenido por lo que en general se requeriría una validación posterior de la metodología. 
El método de productividad de la FAO estructurado en un sistema de información geográfico es flexible para 
incorporar rutinas de cálculo de manera modular. De acuerdo con la información disponible la estimación de Ymax, 
ETmax y Eta pueden cambiarse empleando metodologías más precisas pero por lo general más complejas. 
En una etapa posterior, la mejora del procedimiento debiera tener en cuenta también la diferente sensibilidad al 
estrés hídrico de los cultivos en sus distintas etapas fenológicas, como así también el empleo de información de 
precipitación distribuída espacialmente, empleando estimadores derivados de satélites. 
Además, el NDVI derivado de MODIS podría ser reemplazado por datos NDVI obtenidos a partir de MSG 
(SEVIRI-Instrument) que actualmente está disponible. 
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